
Paint Shop Pro 6.02 
Release Notes

Thank you for purchasing Jasc Paint Shop Pro™ 6! Our newest release of Paint Shop Pro is 
packed with powerful new features and enhancements, including Jasc Animation Shop™ 2.  
Once you begin using these programs, we think you will see just how easy it can be to create 
Web graphics and enhance digital photos.

Please remember that this is a licensed version of Paint Shop Pro, and cannot be freely 
distributed.  See the license agreement information included in this document for limits on 
copying this software and other important information.
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Changes in Paint Shop Pro 6.02
The following improvements were implemented in this version:
· Antialiasing of circular selections produces smoother edges
· The “Browse” button in the Custom Brush dialog box properly supports folder selection
· A new StudioAvenue.com account can be created directly from the Send to 

StudioAvenue.com dialog box by pressing the “New User” button
· Synthetic bold characters are rendered accurately under Microsoft® Windows NT®  4.0
· The “Print” action assigned to the Paint Shop Pro 6 Image file type works correctly through 

Windows Explorer
· The program will set a default directory if an “Output folder” location is not specified in the 

Batch Conversion dialog box
· A connection issue affecting direct camera support for some Olympus, Fuji, and Polaroid 

models has been corrected

Changes in Animation Shop 2.02
The following improvements were implemented in this version:
· The Optimization Wizard now blends partially transparent pixels correctly when the 

document canvas is opaque.  
· Frames are now correctly placed when created via drag and drop from the Paint Shop Pro 

Browser.

Changes in Paint Shop Pro 6.01



Paint Shop Pro 6.01 includes a new feature along with several enhancements and improvements 
to program operation. A brief description of the most significant changes in this version is 
provided below.  Please consult the application help file for further information about the program.

New Features
· Paint Shop Pro 6.01 now allows you to easily post files to Jasc StudioAvenue.com™, our 

new online community for sharing files with others.  To use this new service, either open one 
or more images or select one or more browser thumbnails, then select the 
Export>StudioAvenue.com… command on the File menu.  Selected browser thumbnails can 
also be exported to StudioAvenue.com by right-clicking on any of them and selecting the 
Sent to StudioAvenue.com… command from the resulting context menu.  For further 
information on creating and using your free StudioAvenue.com account, please see the Help 
section of the Jasc StudioAvenue.com home page at www.studioavenue.com.  For further 
information on uploading files to StudioAvenue.com using Paint Shop Pro, please consult the
application help file.

Feature Enhancements
· The program has been updated for greater compatibility with Microsoft® Windows® 2000
· The program now synthesizes bold, italic, or normal TrueType and PostScript variants of a

font if one or more installed variants are present
· Several new cameras are directly supported through the Jasc Software Digital Camera 

installation program. Please refer to the Obtaining and Installing Direct Digital Camera 
Support section of this document for more information

· Control and output improvements have been added to Multiple Image Printing, including:
· Page Setup is accessible in the Multiple Image Printing interface
· Page Setup and Close buttons have been added to the Multiple Image Printing toolbar
· One or more images can be loaded directly into Multiple Image Printing from the Paint 

Shop Pro Browser
· Registration and crop marks can be added to output
· The printing quality has been improved

· Foreground and Background color selectors have been added to the Recent Colors dialog 
box

· The Picture Frame Wizard can now add a frame to the outside of an image
· The Adjust Highlight/Midtone/Shadow dialog box allows the user to set values using either 

the Linear method (as offered in Paint Shop Pro version 5) or the Dynamic method 
introduced in version 6.0

· All Preset Shapes are available as selection types with the Selection tool
· The layer group value can be decreased by right-clicking on the Layer Group Toggle button
· Additional keyboard commands are available in node editing mode as indicated in the 

application help file

Improvements to Program Operation
· Multiple Image Printing has been updated to address issues with remembering printer 

settings and determining proper page margins
· Supported CorelDRAW® (.CDR) files open properly when stored on drives other than the 

program’s host drive
· Vector object display is refreshed when toggling between Paint Shop Pro and other open 

applications using the <Alt> + <Tab> keyboard combination while in node editing mode
· The outline of odd-numbered width lines is properly positioned in relation to the tool cursor 

when creating lines using the Draw tool
· When cutting or copying a vector text selection on a path, the unselected path is no longer 

placed in the clipboard
· An issue that could cause application instability under Windows NT4 and Windows 2000 

when creating vector shapes has been corrected



· A problem that could cause the application to stall when resizing the canvas of large images
has been corrected

· Ampersand characters in file names appear correctly in Browser tool tips
· The Redo command restores Horizontal and Vertical Perspective deformations applied with 

a negative percentage effect value
· The Undo command will now remove layers added to an image by dragging them from the 

Browser
· When closing Animation Shop frames exported to Paint Shop Pro via the File > Close 

command, a confirmation prompt to update the source animation is displayed
· The Full Screen Preview and Full Screen Edit modes support secondary monitors under 

Windows 2000 and Windows 98
· The Page Setup dialog box retains margin values when the system’s Measurement System 

is set to “Metric”
· A problem that could cause application instability when enabling or disabling the “Display 

large text and icons on palettes” setting has been corrected
· The Gradient Editor properly functions if all preset gradients are deleted in either the 

Gradient Editor or Windows Explorer
· A problem that could cause application instability when using the Copy Merged command 

when a floating selection is outside of the image canvas has been corrected
· Image resolution is properly retained when saving Windows or OS/2 Bitmap (.BMP) format 

files
· Selections loaded from an Alpha Channels are properly placed in duplicates of the original 

image

Changes in Animation Shop 2.01
Animation Shop 2.01 includes several enhancements and improvements to program operation.  A
brief description of the most significant changes in this version is provided below. Please consult 
the application help file for further information about the program.

Feature Enhancements
· The program has been updated for greater compatibility with Microsoft® Windows® 2000
· The Frame View scroll bar now allows the user to scroll horizontally within a frame when the

full width or height of a frame is not visible at the current zoom level
· The application file format preferences now include a page for setting PostScript® 

preferences.
· When dragging-and-dropping frames between two animations, the center of the source 

animation registration mark can be snapped to the center of the target animation registration 
mark by holding down the <Shift> key

· Foreground and Background color selectors have been added to the Recent Colors dialog 
box

· Multiple Image Network Graphic (MNG) output support has been improved for greater 
compatibility with other applications

· When performing system intensive operations on large files, a “Busy” cursor is displayed to 
indicate program status

Improvements to Program Operation
· The Undo and Redo commands support changes made by the Optimization Wizard
· AVI files open when dragged-and-dropped on the application icon
· Registration marks are positioned properly after resizing an animation
· Duplicate and inaccurate hotkeys have been corrected throughout the application.
· The Banner Wizard’s “Transition” page retains settings when using the Back button
· Current and selected frames retain their selection state after using the Optimization Wizard.
· An issue that could cause a “Server busy” error when dragging images from the Paint Shop 

Pro workspace or Browser and dropping them into Animation Shop has been addressed.
· When zooming in, the Zoom tool now centers the frame on the point being clicked



· Entries in the “Number of colors” droplist of the Colors tab in the Customize Optimization 
Settings dialog box have been renamed to “3”, “7”, “15”, etc., to accurately reflect the 
wizard’s ability to utilize transparency

· The Animation Wizard allows the user to continue assembling an animation if one or more of
the images cannot be loaded. If the user attempts to add problematic files, a message box 
will display to indicate the problem. After responding to this message box, the application will 
return to the Add Files section of the wizard.

· When placing text in a frame, the text will be placed correctly in relation to the selected 
alignment option

Changes in Paint Shop Pro 6.0
We have added several great new features and enhancements to Paint Shop Pro 6.0.  A brief 
description of what we feel are the most significant changes is provided below.  For a more 
detailed explanation of these features, please consult the Paint Shop Pro 6 Help file.

· Vector object and text tools for creating editable shapes, lines, and text
· Character-level formatting control over Text tool output, including font, point size, color, 

leading, and kerning
· Text placement on a path for bending text to circles, lines, or any other desired shape
· Node-level drawing and editing for powerful, easy creation and manipulation of vector 

objects
· Vector text to shape conversion for applying deformations or editing nodes of character 

shapes
· Adjustment Layers for applying editable color and tonal corrections without affecting the 

content of other layers in an image
· Several new effects and deformations, including Inner and Outer Bevel, Sculpture, Warp, 

Kaleidoscope, and many more for creating unique and eye-catching results
· Flood Fill tool support for gradients with two or more colors to create complex color 

gradients, along with full control over variations in gradient opacity
· Gradient Editor for creating, editing, and saving custom color gradients
· Multiple Image Printing for arranging and printing several images on the same sheet of 

paper
· GIF and JPEG Exporters for easy optimization and output of graphics for the Web
· Enhanced direct digital camera support
· Multiple-level redo and a Command History for quickly removing or restoring one or more 

editing changes to an image before it is saved
· Picture Frames for easily adding attractive frame borders to an image
· Digimarc® digital watermarking for embedding and reading copyright and creator 

information in an image
· Expanded functionality of palette controls for easier access to tool options and layer 

manipulation, viewing, and management
· Automatic palette and Histogram roll-ups to maximize application workspace
· Enhanced display quality, drag and drop support, thumbnail selection capabilities, and 

access to image information in the Paint Shop Pro Browser for viewing and managing 
supported image files

· Folder history and ability to add favorite folders in the Browse for Folder dialog box allows 
quicker access when selecting a folder for browsing, using the Browser to copy or move files,
or selecting plugin and custom brush folders

· Enhanced navigation control in image adjustment previews for focusing on how adjustments
will effect specific areas of an image

· Easier access to application preferences
· Enhanced color selection control, including one-click access to a set of common and 

recently used colors through the Color palette and many image adjustment dialogs
· Easier modification of numeric values for brush sizes, effect values, and more using a new 

“numeric edit control”



· Screen captures can now be activated directly from an OLE client application such as 
Microsoft Word to easily insert a screen capture into a document, spreadsheet, email, 
presentation, or other document type supported by the client application

· Support for eraser functionality with WinTab-compliant pressure sensitive tablets
· Enhanced PostScript and Adobe Photoshop PSD format support
· Easier management of custom resources such as picture tubes, paper textures, and 

patterns
· Enhanced zoom control allows a zoom in level of 32:1 and a zoom out level of 1:24
· A Picture Tube Converter utility for converting custom Paint Shop Pro 5 picture tubes for 

use in Paint Shop Pro 6
· The new Help system includes a convenient “How do I…” section to get you started working

with the program quickly and a new interface for easier navigation and access to information

Changes in Animation Shop 2.0
We have added several great new features and enhancements to Animation Shop 2.0.  A brief 
description of what we feel are the most significant changes is provided below.  For a more 
detailed explanation of these features, please consult the Animation Shop 2 Help file.

· A Banner Wizard for quickly generating text banner animations
· Several new effects and transitions, including Pinwheel, Star Wipe, Sliding Boxes, and many

more for creating unique and eye-catching results
· Options to insert or apply effects to an animation allow you to generate new frames or 

simply apply the effect or transition to one or more selected frames without adding new 
frames

· Line and Shape tools allow you to add normal lines, Bézier curves, and outlined or filled 
rectangles, squares, circles, or ellipses to animation frames

· The Registration Mark tool allows you to place a cross hair at the same location in every 
animation frame for ensuring precise placement when performing operations such as 
dragging and dropping frames or using one of the frame editing tools

· The Crop tool allows you to easily remove all undesired content, such as empty canvas 
area, from all frames in an animation to reduce the file size and download time.  Cropping 
operations can also be set to retain only the opaque or animated areas of the animation 
frames

· The Cull feature allows you to remove one frame for every user-defined number of frames in
an animation to reduce file size and download time

· Video for Windows (AVI) and Autodesk FLI and FLC animation files can now be opened 
and saved within Animation Shop for greater output compatibility with other applications

· Multiple-level redo allows you to quickly restore one or more editing changes to an 
animation before saving it

· The Optimization Wizard now provides the ability to optimize AVI, FLC and FLI formats, as 
well as convenient new options for handling partially transparent pixels when optimizing an 
animation for output in GIF format

· Enhanced integration with Paint Shop Pro 6 allows one or more frames to be exported to 
Paint Shop Pro for editing and updated directly back to Animation Shop

· Frames can be dragged and dropped into Paint Shop Pro 6 or from the Paint Shop Pro 6 
Browser to Animation Shop

· Individual or multiple animation frames can be saved with several file naming options for 
easier file management

· Enhanced color selection control, including one-click access to a set of common and 
recently used colors through the Color palette and effect dialogs

· Additional options are available when opening supported files with multiple layers
· Frames can be selected even if they are not in consecutive order, allowing greater control 

over manipulation of multiple animation frames
· Enhanced zoom control allows a zoom in level of 32:1 and a zoom out level of 1:24



· Paste As New Animation provides a quick method of creating a new animation from one or 
more frames of an existing animation or from a Paint Shop Pro Image

· HTML source code for inserting an animation into a Web page can be quickly accessed and 
copied to the clipboard using the View HTML Code feature

· Enhanced PostScript format support
· The new Help system includes a convenient “How do I…” section to get you started working
with the program quickly and a new interface for easier navigation and access to information

Obtaining and Installing Direct Digital Camera Support
In addition to supporting TWAIN-compliant digital cameras, Paint Shop Pro also provides direct 
support for many of the most popular digital cameras.  Direct digital camera support provides a 
more powerful interface with cameras than those typically available through the standard TWAIN 
interface.  This support is enabled through a separate installation program included on the Paint 
Shop Pro 6 CD-ROM.  This installation program is also available for download from the Digital 
Camera Support Download Page on our Web site at http://www.jasc.com/dcsdl.html.  A list of 
supported cameras is also available at this location.

When Paint Shop Pro 6 is installed from the CD-ROM, the installation program will prompt you to 
install digital camera support.  If you do not wish to install digital camera support during 
installation of Paint Shop Pro, you can run it later using the instructions provided below.  If you do
not have the Paint Shop Pro 6 CD-ROM, you can download the Jasc Software Digital Camera 
Support setup program from the Web page indicated above.

To install direct digital camera support, proceed as follows:
1. Download the Jasc Software Digital Camera Support setup program (DCSETUP.EXE) or run 

it from the Paint Shop Pro 6 CD-ROM by inserting the CD into your CD-ROM drive and 
selecting the “Install Digital Camera Support (CD Required)” shortcut in the Paint Shop Pro 6 
folder of the Start Menu.

2. Select the manufacturer of your camera.  You can select multiple manufacturers if desired.
3. The installation program will install the necessary files for accessing the selected camera(s) 

and close after the installation is complete.
4. Once the desired support is installed, you can configure and access the camera using the 

Import>Digital Camera commands on Paint Shop Pro’s File menu.

Important Note for Microsoft® Windows® 95 Users
If you are using the original release of Windows® 95 (version 4.00.950) and have not installed 
Internet Explorer v. 3.0 or higher, you will have to update the Windows 95 common control library
in order to run Paint Shop Pro.  An update program to perform this upgrade is available in the \
Psp\Comctlup folder on the Paint Shop Pro 6 CD-ROM.  The filename is 40COMUPD.EXE.

If you do not have the Paint Shop Pro 6 CD-ROM or you are using an evaluation version of Paint 
Shop Pro 6, you can download this update program at the following address: 

ftp://ftp.jasc.com/helpers/40comupd.exe

If you encounter problems when attempting to download the file, please contact our Technical 
Support department for assistance.

Obtaining Technical Support

Technical support for Paint Shop Pro 6 and Animation Shop 2 can be obtained from:

Jasc Software, Inc.
PO Box 44997



Eden Prairie, MN 55344 USA
Voice: (612) 930-9171
Fax: (612) 930-9172
Internet: techsup@jasc.com
Web: http://www.jasc.com

International customers can also contact their regional distributor for technical support.  To obtain
contact information for your regional distributor, please see the International Representatives 
List page on our Web site at http://www.jasc.com/world.html or contact our Technical Support
department using the information provided above.

Software License and Limited Warranty

This is a legally binding agreement between you and Jasc Software, Inc. ("Jasc"). By installing 
and/or using this software, you are agreeing to become bound by the terms of this agreement.

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THIS 
SOFTWARE. PROMPTLY RETURN THE ENTIRE PACKAGE TO THE PLACE WHERE YOU 
OBTAINED IT FOR A FULL REFUND.
 
Grant Of License. Jasc grants to you a non-exclusive right to use this software program 
(hereinafter the "Software") in accordance with the terms contained in this Agreement. You may 
use the Software on a single computer. If you have purchased a site license, you may use the 
Software on the number of computers defined by and in accordance with the site license. 

Upgrades. If you acquired this Software as an upgrade of a previous version, this Agreement 
replaces and supersedes any prior Agreements. You may not continue to use any prior versions 
of the Software. 

Ownership Of Software. Jasc and its suppliers retain the copyright, title and ownership of the 
Software and the written materials. 

Copies. You may make one (1) copy of the Software solely for backup purposes. You must 
reproduce and include the copyright notice on the backup copy. No other copying is permitted. 
You may not distribute copies of the Software or accompanying written materials to others.

Transfers. You may transfer the Software to another person provided that you notify Jasc of the 
transfer and the person to whom you transfer the Software agrees to be bound by this 
Agreement. You may also transfer the Software from one of your computers to another. Upon a 
transfer, you must remove all copies of the Software from the computer from which it was 
transferred. Upon a transfer to a third party you must destroy all backups. In no event may you 
transfer, assign, rent, lease, sell or otherwise dispose of the Software on a temporary basis. 

Termination. This Agreement is effective until terminated. This Agreement will terminate 
automatically without notice from Jasc if you fail to comply with any provision of this Agreement. 
Upon termination you shall destroy the written materials and all copies of the Software, including 
modified copies, if any.

Limited Warranty. Jasc warrants the media on which the Software is furnished to be free of 
defects in material and workmanship, under normal use, for a period of ninety (90) days following
the date of delivery to you. In the event of defects, Jasc's sole liability shall be to (a) replace the 
defective media or (b) refund the purchase price, at Jasc's option. You must return the Software 
to Jasc or an authorized dealer with your dated invoice during the 90-day warranty period in order



to receive a refund or replacement. Jasc or its suppliers provide a Year 2000 Readiness 
Statement as shown below.

DISCLAIMER OF WARRANTIES. JASC DISCLAIMS ALL OTHER WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  

OTHER WARRANTIES EXCLUDED. JASC SHALL NOT BE LIABLE FOR ANY DIRECT, 
INDIRECT, CONSEQUENTIAL, EXEMPLARY, PUNITIVE OR INCIDENTAL DAMAGES 
ARISING FROM ANY CAUSE EVEN IF JASC HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. CERTAIN JURISDICTIONS DO NOT PERMIT THE LIMITATION OR 
EXCLUSION OF INCIDENTAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU.

IN NO EVENT WILL JASC BE LIABLE FOR ANY AMOUNT GREATER THAN WHAT YOU 
ACTUALLY PAID FOR THE SOFTWARE. Should any other warranties be found to exist, such 
warranties shall be limited in duration to ninety (90) days following the date you receive the 
Software.

Export Laws. You agree that you will not export the Software or documentation except in 
compliance with the laws and regulations of the United States.

US Government Restricted Rights. The Software and any accompanying materials are 
provided with Restricted Rights. Use, duplication or disclosure by the Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Commercial 
Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. 
Contractor/manufacturer is Jasc Software, Inc., PO Box 44997, Eden Prairie MN 55344.

General. This Agreement shall be governed by and construed in accordance with the laws of the 
State of Minnesota and the Federal Arbitration Act and shall benefit Jasc, its successors and 
assigns. Any claim or dispute between you and Jasc or against any agent, employee, successor 
or assign of Jasc related to this Agreement or the Software shall be resolved by binding 
arbitration in Minneapolis, MN by and under the rules of the American Arbitration Association. 
Any award of the arbitrator(s) may be entered as a judgment in any court of competent 
jurisdiction. The United Nations Convention on Contracts for the International Sale of Goods shall
not apply to this Agreement.

Year 2000 Readiness Statement

Jasc Software's products are compliant with Standards for the Year 2000. For the purposes of 
this statement, the Standards for Year 2000 shall mean that the documented performance, 
features and functionality of Jasc products will not be affected by dates prior to, during and after 
year 2000; provided that all other products, specifically including the computer's BIOS and 
operating system, properly provide dates to Jasc's products. 

Certain file formats store creation and/or modification dates within the file itself.  Paint Shop Pro 
allows the user to view such information. The following formats are supported by Paint Shop Pro 
and have been tested for Y2K compliance: (1) PNG and PSP store image creation date and time 
and last image modification date and time, (2) TGA and TIF store image creation date and time; 
and (3) PSD stores image creation date.

Other file formats either do not store the information within the file, or are otherwise not 
supported by Paint Shop Pro. Paint Shop Pro lists the image creation date and last modification 
date as "unknown" whenever that information is not supported by the file format.
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